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Preface

CentraSite is installed with the webMethods Installer. Please refer to the webMethods Installer
documentation, which you can find at http://documentation.softwareag.com/.

The product's readme file is recommended for reading.

All product readme files are available at http://documentation.softwareag.com/.

Before You Start Using CentraSite ■ Application Server Tier Configuration
■ Using Terracotta BigMemory
■ ConfiguringHTTPProxySettings for ImportingWSDLs
■ Configuring UDDI
■ Setting up the Eclipse Plug-Ins
■ Installing the Adobe Flash Player
■ Prerequisites for Reading the Online Documentation
■ Problems with Blocked Content

CentraSite Startup, Services andComponents ■ CentraSite Startup Behavior
■ Services and Components
■ UNIX Installation Without Using sudo

After You Uninstall CentraSite

Notation

In the following sections, various terms such as <SuiteInstallDir> are used to represent the disk
locations of installed product components. These terms are described in the document Basic
Operations.
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This section provides information on steps to follow after the installation.

CentraSite Application Server Tier Configuration

By default, the CentraSite installation procedure installs the CentraSite Application Server Tier
on Software AG Runtime.

You can configure your Software AG Runtime environment by adding or modifying Java Service
Wrapper properties for Software AG Runtime. The procedures for doing this are given in the fol-
lowing sections.

After changing any Java ServiceWrapper properties, the SoftwareAGRuntime has to be restarted.

The following topics summarize the configuration possibilities.

■ The Java Service Wrapper Configuration
■ HTTP Proxy Configuration
■ HTTPS (SSL) Proxy Configuration
■ Memory Settings
■ Print Feature on UNIX and Linux Platforms
■ Troubleshooting

The Java Service Wrapper Configuration

The SoftwareAGRuntime,which hosts theCentraSiteApplication Server Tier, runs on the Software
AGCommonPlatform. The Java ServiceWrapper is an application developed by Tanuki Software,
Ltd. It is a utility program that launches the Java Virtual Machine (JVM) in which Software AG
Runtime runs.

In addition to launching the JVM, the Java Service Wrapper offers features for monitoring the
JVM, logging console output, and generating thread dumps. The following sections describe how
CentraSite uses the features of the Java Service Wrapper. For an overview of the Java Service
Wrapper, see thewebMethods cross-product document,Working with the webMethods Product Suite
and the Java Service Wrapper.
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The Java Service Wrapper Configuration Files

The configuration files for the Java Service Wrapper reside in the following directory.

<SuiteInstallDir>/profiles/CTP/configuration

When you start Software AG Runtime, property settings in the following files determine the con-
figuration of the JVM and the behavior of the logging and monitoring features of the Java Service
Wrapper.

DescriptionFile name

Contains property settings that are installed for the Java Service Wrapper.wrapper.conf
Do not modify the contents of this file unless asked to do so by Software AG.

Contains properties that modify the installed settings in wrapper.conf.custom_wrapper.conf

If you need to modify the property settings for the Java Service Wrapper, you make
your changes in this file.

The following sections describe configuration changes that CentraSite supports for Java Service
Wrapper. For CentraSite, do not make any configuration changes to the Java Service Wrapper
other than the ones described in the following sections.

JVM Configuration

When the Java Service Wrapper launches the JVM, it provides configuration settings that, among
other things, specify the size of the Java heap, the size of the PermGen etc.

JVM Configuration Properties

The properties which starts withwrapper.java in the Java Service Wrapper configuration files
determine the configuration of the JVM in which the Software AG Runtime runs.

You canmodify the following JVM property settings to suit your needs. For procedures and addi-
tional information, see the webMethods cross-product document,Working with the webMethods
Product Suite and the Java Service Wrapper.

ValueProperty

Initial size (in MB) of the Java heap.wrapper.java.initmemory

Maximum size (in MB) to which the Java heap can grow.wrapper.java.maxmemory

Additional Java parameters to be passed in on the command line.wrapper.java.additional.n
Example:
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ValueProperty

-XX:MaxPermSize=256M

The Wrapper Log

The Java Service Wrapper records console output in a log file. The log contains the output sent to
the console by the wrapper itself and by the JVM in which the Software AG Runtime is running.
The wrapper log is especially useful when the Software AG Runtime runs as a Windows service,
because console output is normally not available to you in this mode.

The Java Service Wrapper log for CentraSite is located in the following file:

<SuiteInstallDir>/profiles/CTP/logs/wrapper.log

To view the log, simply open the log file in a text editor.

Logging Properties

The properties start withwrapper.console and wrapper.log in the wrapper configuration files
determine the content, format, and behavior of the wrapper log.

The logging settings that CentraSite installs are suitable for most environments. However, you
canmodify the following properties if the installed settings do not suit your needs. For procedures
and additional information, see the webMethods cross-product document,Working with the web-
Methods Product Suite and the Java Service Wrapper.

ValueProperty

Level of messages to display in the console.wrapper.console.loglevel

Format of messages in the console.wrapper.console.format

File in which to log messages.wrapper.logfile

Level of messages to write in the log file.wrapper.logfile.loglevel

Format of messages in the log file.wrapper.logfile.format

Maximum size to which the log can grow.wrapper.logfile.maxsize

Number of old logs to maintain.wrapper.logfile.maxfiles

Level of messages to write to the Event Log on Windows systems or the
syslog on UNIX.

wrapper.syslog.loglevel
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Fault Monitoring

The Java ServiceWrapper canmonitor the JVM for the certain conditions and then restart the JVM
or perform other actions when it detects these conditions.

The following table describes the fault-monitoring features CentraSite uses or allows you to con-
figure. To learn more about these features, see the webMethods cross-product document,Working
with the webMethods Product Suite and the Java Service Wrapper.

User configurable?Enabled?Feature

Yes. See JVM Timeout Properties below.YesJVM timeout
Do not change the installed settings unless asked to do so by Software AG.

Yes. See Deadlock-Detection Properties below.NoDeadlock detection

Yes. See Console Filtering Properties below.NoConsole filtering

JVM Timeout Properties

The properties start withwrapper.ping in the wrapper configuration files determine the ping in-
terval and timeout period. Touse timeout-detectionwithCentraSite, you can configure the following
properties. See the webMethods cross-product document,Working with the webMethods Product
Suite and the Java Service Wrapper for procedures and additional information.

Example:

The following simple example will configure the Wrapper to ping the JVM every 5 seconds and
automatically restarts the JVM if it does not receive a response to a ping within 30 seconds.

wrapper.ping.timeout=30
wrapper.ping.interval=5
wrapper.ping.timeout.action=RESTART

ValueProperty

The length of time, in seconds, that the Java Service Wrapper waits for
a response to a ping. If it does not receive a response in the specified

wrapper.ping.timeout

time, it initiates the action specified in
wrapper.ping.timeout.action.

The default value is 30 seconds.

If this value is modified, the preferred value for CentraSite is 60
seconds.
Example:
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ValueProperty

wrapper.ping.timeout=60

How often, in seconds, the Java Service Wrapper pings the JVM to
determine whether it is active.

The default value is 5 seconds.
Example:

wrapper.ping.interval

wrapper.ping.interval=5

The action that occurs if the Java Service Wrapper does not receive a
response to a ping in the allotted time.

The default action is RESTART.

If this value is modified, the preferred value for CentraSite is
DEBUG,DUMP,RESTART.

wrapper.ping.timeout.action

Example:

wrapper.ping.timeout.action=DEBUG,DUMP,RESTART

Deadlock-Detection Properties

The wrapper.check.deadlock properties in the wrapper configuration files determine whether
the wrapper monitors the JVM for deadlocks and what action it takes when a deadlock occurs. To
use deadlock-detection with CentraSite, you can configure the following properties. See the web-
Methods cross-product document,Working with the webMethods Product Suite and the Java Service
Wrapper for procedures and additional information.

Example:

The following simple example will configure the Wrapper to log the location of a deadlock and
then immediately restart the JVM.

wrapper.check.deadlock=TRUE
wrapper.check.deadlock.interval=60
wrapper.check.deadlock.action=RESTART
wrapper.check.deadlock.output=FULL
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ValueProperty

Flag (TRUEor FALSE) that enables or disables deadlock detection.wrapper.check.deadlock

The default setting is FALSE.
Example:

wrapper.check.deadlock=FALSE

How often, in seconds, the Java Service Wrapper evaluates the
JVM for a deadlock condition.

The default value is 60 seconds.
Example:

wrapper.check.deadlock.interval

wrapper.check.deadlock.interval=60

Action that occurs if the Java ServiceWrapper detects a deadlock
condition. Software AG recommends that you specify the DUMP,
RESTART actions if you enable deadlock detection for CentraSite.

The default action is RESTART.

If this value is modified, the preferred value for CentraSite is
DUMP,RESTART.

wrapper.check.deadlock.action

Example:

wrapper.check.deadlock.action=DUMP,RESTART

Information to be logged if the Java Service Wrapper detects a
deadlock condition. Software AG recommends that you specify
the FULL output if you enable deadlock detection for CentraSite.

The default output level is FULL.
Example:

wrapper.check.deadlock.output

wrapper.check.deadlock.output=FULL

Console Filtering Properties

The wrapper.filter properties in thewrapper configuration files determinewhether thewrapper
monitors the console for specified messages and what action it takes when a specified message
occurs. To use console filtering with CentraSite, you can configure the following properties. See
the webMethods cross-product document,Working with the webMethods Product Suite and the Java
Service Wrapper for procedures and additional information.

7Post Installation and Additional Uninstallation Steps for CentraSite

Before You Start Using CentraSite



ValueProperty

Required. String of text that you want to detect in the console
output.

wrapper.filter.trigger.n

Example:

wrapper.filter.trigger.1=OutOfMemoryError

Required. Action that occurs when the Java Service Wrapper
detects the string of text.

The default action is RESTART.
Example:

wrapper.filter.action.n

wrapper.filter.action.1=RESTART

Flag (TRUE or FALSE) that specifies whether the Java Service
Wrapper processes wildcard characters that appear in
wrapper.filter.trigger.n.

The default setting is FALSE.
Example:

wrapper.filter.allow_wildcards.n

wrapper.filter.allow_wildcards.1=TRUE

Message that displays when Java Service Wrapper detects the
string of text.
Example:

wrapper.filter.message.n

wrapper.filter.message.1=The JVM has run out of ↩
memory.

Generating a Thread Dump

The Java Service Wrapper provides a utility for generating a thread dump of the JVM when the
SoftwareAGRuntime is running as aWindows service. A thread dump can help you locate thread
contention issues that can cause thread blocks or deadlocks.

For information about generating a thread dump using the Java Wrapper Service, see the web-
Methods cross-product document,Working with the webMethods Product Suite and the Java Service
Wrapper.
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HTTP Proxy Configuration

If you use an HTTP proxy to access the Internet, add the following Java system properties to the
custom_wrapper.conf file in <SuiteInstallDir>/profiles/CTP/configuration folder on the machine
where the Software AGRuntime is installed. For information about setting Java system properties
in custom_wrapper.conf, see thewebMethods cross-product document,Working with the webMethods
Product Suite and the Java Service Wrapper.

wrapper.java.additional.<n>=-Dhttp.proxyHost=httpprox.<3rd-level-domain>.<2nd-level-domain>
wrapper.java.additional.<n>=-Dhttp.proxyPort=<proxy_port_number>
wrapper.java.additional.<n>=-Dhttp.nonProxyHosts="*.<3rd-level-domain>.<2nd-level-domain>|*.<domain_1>.<extension>|*.<domain_2>.<extension>"

Note: <n> is a unique sequence number that you assign to each wrapper.java.additional

property associated with the Java Service Wrapper. For more information about assigning
this sequence number, see the wrapper.java.additional property description in the cross-
product document,Working with the webMethods Product Suite and the Java Service Wrapper.

The -Dhttp.nonProxyHosts setting should specify at least the name of the host on which the
Software AG Runtime is running. If there is more than one entry in this list, separate the entries
with the vertical bar character "|".

The following are cases of particular interest in which you may need to set the proxy settings:

■ In order to have access to or to import WSDL files from the Internet.
■ In the Software AG Runtime where CentraSite Control is running.
■ If you embed the importer in an application, then these setting will also apply.

HTTPS (SSL) Proxy Configuration

If you use an HTTPS proxy to access the Internet, add the following Java system properties to the
custom_wrapper.conf file in <SuiteInstallDir>/profiles/CTP/configuration folder on the machine
where the Software AGRuntime is installed. For information about setting Java system properties
in custom_wrapper.conf, see thewebMethods cross-product document,Working with the webMethods
Product Suite and the Java Service Wrapper.

wrapper.java.additional.<n>=-Dhttps.proxyHost=<sslproxy>
wrapper.java.additional.<n>=-Dhttps.proxyPort=<port>

Without this setting, any operation requiring HTTPS, such as importing a WSDL/BPEL/XSD file
via HTTPS, may fail with messages like: "The WSDL file is unreachable. Make sure the input in-
formation is correct".
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Memory Settings

If you want to change Permanent Generation size, add the following Java system property to the
custom_wrapper.conf file in <SuiteInstallDir>/profiles/CTP/configuration folder on the machine
where the Software AG Runtime is installed. For information about setting Java system property,
see the webMethods cross-product document,Working with the webMethods Product Suite and the
Java Service Wrapper.

wrapper.java.additional.<n>=-XX:MaxPermSize=<memorySize>

Print Feature on UNIX and Linux Platforms

If the Software AG Runtime is running on a UNIX or Linux platform and you want to use the
print feature, you must set Java AWT to be set to headless mode. You must set headless mode, for
example, if you want to perform instance printing or preview BIRT reports.

To set Java AWT to headless mode, add the following Java system property to the custom_wrap-
per.conf file in <SuiteInstallDir>/profiles/CTP/configuration folder on the machine where the
Software AG Runtime is installed. For information about setting Java system property, see the
webMethods cross-product document,Workingwith the webMethods Product Suite and the Java Service
Wrapper.

wrapper.java.additional.<n>=-Djava.awt.headless=true

Troubleshooting

If a web application shows unexpected behavior such as “hanging” or refuses to proceed, you
should first check the Software AG Runtime log file. The location of the current Software AG
Runtime log file is given in the logging property "wrapper.logfile" of the wrapper.conf file.

Securing Communication Between CentraSite Application Server Tier and
CentraSite Registry Repository

You can configure a secure communication between the CentraSite Application Server Tier and
the CentraSite Registry Repository by executing the following commands in the command line
interface CentraSiteCommand.cmd (Windows) or CentraSiteCommand.sh (UNIX) of Command
Central. The tool is located in <CentraSiteInstallDir>/utilities.

If you start this command line tool with no parameters, you receive a help text summarizing the
required input parameters.

The parameters of the command are case-sensitive, so for example the parameter "-file" must be
specified as shown and not as "-FILE".
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Securing the CentraSite Application Server Tier

To secure the CentraSite Application Server Tier, use a command of the following form:

CentraSiteCommand set AST security -file <CONFIG-FILE>

The following table describes the complete set of input parameters that you can use with the set
AST security utility:

DescriptionParameter

The URI (file: or http:) of the configuration file.-file

For example:

CentraSiteCommand set AST security -file "config.xml"

Securing the CentraSite Registry Repository

To secure the CentraSite Registry Repository, use a command of the following form:

CentraSiteCommand set RR security -file <CONFIG-FILE>

The following table describes the complete set of input parameters that you can use with the set
RR security utility:

DescriptionParameter

The URI (file: or http:) of the configuration file.-file

For example:

CentraSiteCommand set RR security -file "config.xml"

Using Terracotta BigMemory

Terracotta BigMemory is a separately-licensed add-on product that allows you to use vast amounts
of off-heap cachememory for the storage of application data. By significantly reducing the depend-
ency ondisk-basedprocessing, applications that use BigMemory can runwith huge speed increases.

For general information about Terracotta BigMemory usage within the webMethods Suite, refer
to the SystemRequirements, Installation, andUpgrade section of thewebMethods Suite on the Software
AG documentation web site.
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To activate BigMemory processing for CentraSite, you need to carry out the following steps:

■ Setting up the license to use Terracotta BigMemory
■ Configuring CentraSite to use Terracotta BigMemory

Setting up the license to use Terracotta BigMemory

In CentraSite, Terracotta BigMemory can be used in 3 places:

■ in web applications (CentraSite Control, Importers etc.) all residing in Software AG Runtime
■ in Eclipse/Software AG Designer environments
■ in client applications

Web applications in Software AG Runtime use internal mechanisms to locate the license file, so
you do not need to modify anything here.

For Eclipse/Software AG Designer and client applications, you need to specify the location of the
license file explicitly. The license file can be placed in any directory, but Eclipse/Software AG De-
signer or the client application must be started with the following Java property:

-Dcom.tc.productkey.path=<path to license file>

For example:

-Dcom.tc.productkey.path=C:\SoftwareAG\common\conf\terracotta-license.key

Configuring CentraSite to use Terracotta BigMemory

You need to perform some steps in order to configure CentraSite to use BigMemory.

To configure CentraSite to use BigMemory

1 On the CentraSite Registry Repository node, open a command line and go to the CentraSite
bin directory (<SuiteInstallDir>/CentraSite/bin).

2 Execute the script centrasite_setenv.

3 Execute the command:
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java -jar ↩
CentraSiteCacheConfiguration.jar <CentraSite_URL> <AdministratorID> <Password>

SET maxMemoryOffHeap <Size><Unit>

where Unit can be any of : k, K,m,M, g, G, t, T (for kilobytes,megabytes, gigabytes, terabytes)

For example, the command for setting a BigMemory cache of 20 gigabytes with an administrator
account "INTERNAL\Admin" and password "AdminPW" would be:

java -jar CentraSiteCacheConfiguration.jar ↩
"http://localhost:53307/CentraSite/CentraSite" "INTERNAL\Admin" "AdminPW" 
     SET maxMemoryOffHeap 20G ↩

Configuring HTTP Proxy Settings for Importing WSDLs

In order to have access to or to import WSDL files from the internet, the following Java system
properties should be set for the Java Service Wrapper:

Syntax Example:

-Dhttp.proxyHost=httpprox.<3rd-level-domain>.<2nd-level-domain>
-Dhttp.proxyPort=8080
-Dhttp.nonProxyHosts="*.<3rd-level-domain>.<2nd-level-domain>|*.<domain_1>.<extension>|*.<domain_2>.<extension>"

There are two occurrences in which you may need to set the proxy settings:

■ In the Software AG Runtime where CentraSite Control is running.
■ If you call theWSDL importer from the command line or embed the importer in an application,
then these setting will also apply.

Configuring UDDI

The default behavior of the UDDI processing in CentraSite can be configured using global and
local properties. These properties are set on the CentraSite Application Tier Server (CAST) where
the UDDI Registry web application runs that handles UDDI client requests to CentraSite. If your
environment contains more than one CAST, you can modify the properties on each CAST.

For information about setting up these properties, refer to the section Configuring the UDDI Envir-
onment in the document Access via UDDI.
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Setting Up the Eclipse Plug-Ins

The CentraSite distribution kit includes Eclipse plug-ins that allow you to use Eclipse as an altern-
ative to CentraSite Control. You can either use the plug-ins with the Eclipse kit that is included in
the CentraSite kit, or, if you already have an installed Eclipse environment, you can add the plug-
ins to that environment.

The plug-ins follow the paradigms of the Eclipse Workbench: Views, editors, and a perspective
are provided for displaying the contents of a CentraSite registry and repository. Actions can be
carried out from context menus and toolbars. The working environment can be customized using
standard Eclipse Workbench functions. For detailed information on the Eclipse Workbench, refer
to theWorkbench User Guidewhich comes with Eclipse.

The CentraSite Eclipse plug-ins include report design features which make use of the Business
Intelligence andReporting Tools (BIRT) provided by the Eclipse Foundation. You can find examples
in the tutorials, which are in the Software AGdocumentationweb site: http://documentation.soft-
wareag.com/.

For general information about Eclipse, see http://www.eclipse.org/.

■ Installing the CentraSite Eclipse Plug-Ins
■ Using your Existing Eclipse Environment
■ Connecting from Eclipse to CentraSite
■ Starting to Work with the CentraSite Plug-ins for Eclipse
■ Getting Help

Installing the CentraSite Eclipse Plug-Ins

The CentraSite installation procedure includes an option to install the Software AG Designer
component, which is an Eclipse installation tailored for CentraSite. If you did not select this option
during theCentraSite installation, you can run theCentraSite installation procedure again, selecting
just this option.

If the Software AG Designer has not yet been installed, run the Software AG Installer and select
the SoftwareAGDesigner plus theCentraSite specific plug-ins as shown in the following screenshot.
If you wish to perform CentraSite reporting using BIRT, select "SOA Governance" also.
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Installing the SoftwareAGDesignerwill, among other actions, add a suitable entry to theWindows
Start menu.

Using your Existing Eclipse Environment

If you already have an Eclipse working environment, you can install the CentraSite plug-ins in
the existing environment rather than installing a new Eclipse from the CentraSite kit.

The distribution of CentraSite includes a set of Eclipse plug-ins for development purposes. The
CentraSite Eclipse plug-ins provide a graphical user interface that you can use to create and
manage the information in a CentraSite registry and repository.

The CentraSite Eclipse plug-ins can be used with Eclipse on any of the supported platforms.

Note: SoftwareAG recommends using the same version of Eclipse as SoftwareAGDesigner
uses.

Installing Eclipse

The first prerequisite for Eclipse is a Java runtime environment (JRE), which can be downloaded
from http://www.oracle.com/technetwork/java/index.html.

Eclipse (with the BIRTReportDesigner plug-in) can be downloaded fromeclipse project downloads
(http://www.eclipse.org/downloads/). If you wish to use the CentraSite reporting feature (based
on BIRT), you require the Eclipse IDE for Java and Report Developers. The Eclipse download page
offers integrated packages that contain both BIRT and the required Eclipse software. If you do not
wish to use the CentraSite reporting feature, you can use the Eclipse IDE for Java Developers.

Installing Eclipse simply copies a folder called eclipse into the file system. Consequently, uninstalling
Eclipse simply means deleting this folder including all its subfolders.
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Workspaces

The files that are created when working with Eclipse are contained in projects, which in turn are
bundled in workspaces. An Eclipse workspace is a folder at an arbitrary location in the user's file
system, though Eclipse suggests placing the workspace in a folder imaginatively called workspace
underDocuments and Settings/<userid> on the drivewhere Eclipsewas installed.When you create
an Eclipse project, the corresponding folder is created in the current workspace.

Installing CentraSite Eclipse Plug-ins

This software package includes plug-ins for the Eclipse environment (supported on Windows
platforms only). These are unpacked to the installation directory and from there can be installed
into your Eclipse platform. In order to use these plug-ins, the Eclipse SDK must be available as a
prerequisite. Check the webMethodsSystem Requirements for the supported version of Java (ht-
tp://documentation.softwareag.com/).

To install the CentraSite plug-ins in the Eclipse environment

1 Start the Eclipse in which the plug-ins are to be installed.

2 From the menu entryHelp, select the item to install new software. This can be for example
Install New Software or Software Updates, depending on the Eclipse version you are using.

This takes you to theAvailable Softwaredialog. On some Eclipse versions, youmight instead
see the Software Updates and Add-ons dialog; if so, select the tab Available Software.

3 Choose Add or Add Site. This takes you to the Add Repository dialog, where you specify
the location of the plug-ins.

Choose Archive and navigate to the following location: <SuiteInstallDir>/eclipse/updates.
There youwill find the zip fileCentraSiteUpdateSite.zip. Select this file, and clickOpen to return
to the Add Repository dialog, then clickOK.

The archive location can also contain optional language packs. If you need a language pack,
install it using the same method as described here.

4 Back in the Available Software dialog, you now see the SOA Governance category under
which the plug-ins are listed.

Click Select All, then clickNext.

5 You may be asked to confirm that you want to perform the installation, and that you agree
to license conditions. Select the appropriate option to confirm. When the Finish button is en-
abled, click it to start the installation.

In some cases you might need to restart Eclipse after the installation has completed, in order
to activate the plug-in.

6 You can now test that the installation was successful.
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To do this, first create a report project using File > New > Project > Business Intelligence and
Reporting Tools > Report Project, then open the Report Design perspective.

Now create a BIRT report using File > New > Report.

7 Open the view Report Design > Data Explorer.

8 Right-clickData Sources, then chooseNew Data Source from the context menu. TheNew
Data Source dialog now displays the CentraSite data sources that you can use to create the
XQuery for generating CentraSite reports.

■ CentraSite
■ CentraSite XQuery

9 SelectCentraSite XQuery from the list of data source types. Use the default data source name,
then chooseNext.

Connection information about the CentraSite data source appears.

Important: Before running the plug-ins, you must restart the Eclipse environment.

Connecting from Eclipse to CentraSite

■ Connection Configuration
■ Proxy Settings

Connection Configuration

To be able to connect the CentraSite data storage, it is necessary to establish a connection config-
uration. This is achieved in the Eclipse Preferences Dialog (reachable from theWindowmenu
entry). This dialog automatically pops up when connection to the data storage is first requested.

In the Preferences dialog, expand the CentraSite node and click Connections. Then click Add to
create a new connection. In the next popup, enter the following information:

■ Name
The name thatwill appear in your list of connections. If you intend to create several connections,
choose a name that will allow you to easily identify this connection.

■ Host
The URL (host and port) of the Software AG Runtime, for example http://localhost:53307.

■ User
The ID of a user who has permission to access the CentraSite Registry Repository.
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When you have entered these 3 fields, click OK. You will be asked to provide the password for
the given user.

Choosing "Save password" avoids having to enter your password for future Eclipse sessions, but
is not recommended in a security-sensitive environment.

You can check that a connection to CentraSite is possible by clicking the Test button.

Proxy Settings

In most scenarios the Eclipse environment's "Native" settings should provide for a flawless con-
nection.

However, should you experience connection problems check the network connection settings
(Window > Preferences > General > Network Connections).

The proxy settings should be the same as for the Software AG Runtime. In this respect pay partic-
ular attention to the non-proxy host settings (see previous chapters of this section).
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Starting to Work with the CentraSite Plug-ins for Eclipse

We recommend starting to work with the CentraSite Eclipse plug-ins by opening the CentraSite
perspective. You can do this, for example, in the following way:

■ SelectWindow > Open Perspective > Other in the main menu of the Eclipse Workbench, then
select the CentraSite perspective.

You can work with theCentraSite perspective just as you would work with any other perspective
in the Eclipse Workbench. The Workbench remembers which views and perspectives you have
opened, and how you have customized your working environment. The next time you open the
Workbench, it appears as you have left it. For detailed information, refer to the Eclipse Workbench
User Guide.

Getting Help

In the same way as the CentraSite Eclipse plug-ins are integrated in the Eclipse Workbench, their
documentation is integrated in the help system of the Eclipse Workbench. The documentation is
provided in a separate plug-in which is installed along with the software.

You can get help in the following ways:

■ SelectHelp > Help Contents.

This displays the books of the Eclipse help system. Here, you can find the CentraSite Plug-Ins
User's Guide, which describes in detail how to work with the CentraSite Eclipse plug-ins.

■ Select a view, menu option, dialog, property page or wizard of the CentraSite Eclipse plug-ins
and press F1 on the keyboard. This displays context-sensitive help for the selected element with
references to the CentraSite Plug-Ins User's Guide.

Installing the Adobe Flash Player

The graphical Impact Analysis feature of CentraSite requires the Adobe Flash Player, which is a
third party web browser plug-in. If you do not already have the Flash Player version 8 or later
installed, please install it from the Adobe web site at http://www.adobe.com/.
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Prerequisites for Reading the Online Documentation

■ HTML Browser

For viewing the online documentation, a browser capable of supporting Java, JavaScript, and
Cascading Style Sheets (CSS) is recommended. The documentation has been successfully tested
with these products:
■ Microsoft Internet Explorer version 8.x.
■ Microsoft Internet Explorer version 7.x.
■ Mozilla Firefox version 3.x.

These browsers are freely available for download.
■ Java Browser Plug-in

The documentation has been successfully tested with the following browser plug-ins:
■ JVM 1.7

Caution: Using Sun Java 6 update 10 may lead to problems.

We recommend going to the Java website to acquire a free Java browser plug-in.
■ PDF Viewing Software

For viewing the PDF documentation:
■ A PDF reader such as the Adobe Readermust be installed.

The Adobe Reader is freely available for download.

Problems with Blocked Content

Software AG documentation uses active content (JavaScript and Java applets). With Service Pack
2 (SP2) for Windows XP, Microsoft introduced a range of powerful new security features. One
effect of these security features is that warning messages appear whenever you try to display
HTML pages that use active content, for example Software AG documentation, in the Internet
Explorer. A typical warning message that appears in the Internet Explorer information bar is:

Caution: To help protect your security, Internet Explorer has restricted this webpage from
running scripts or ActiveX controls that could access your computer. Click here for options...

To continue using the documentation, you can do one of the following:
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■ Use a different web browser. This problem only affects Microsoft's Internet Explorer.

Note: Software AG does not endorse or recommend any web browser.

■ Change the Internet Explorer options to allow active content to run in files on your computer.

To unblock active content

In the Microsoft Internet Explorer:

1 Choose Tools> Internet Options.

2 Choose the tab Advanced.

3 Scroll down to the section Security.

4 Check (tick) the box Allow active content to run in files on My Computer.

5 ChooseOK.

6 Restart the Internet Explorer.

The warning messages should now no longer appear.

■ Click on the information bar and choose the option Allow Blocked Content.... You will have
to do this for each affected page.
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CentraSite Startup Behavior

CentraSite consists of twomain components: SoftwareAGRuntime for the CentraSite Application
Server Tier and CentraSite Registry Repository.

The SoftwareAGRuntime for the CentraSiteApplication Server Tier in general is started automat-
ically when you boot the machine where this component is installed. But, the CentraSite Registry
Repository requires you to make a manual startup.

The startup procedure for CentraSite Registry Repository requires some time to complete (depend-
ing on your configuration, this can be seconds or minutes), so you should wait until the startup
procedure has completed before you begin normal operations.

If you try to start CentraSite components such as CentraSite Control before the CentraSite Registry
Repository is running, you will receive an error message indicating that one or more services are
not available. If this happens, wait a few moments and try again.

Services and Components

A running CentraSite relies on a number of active software components. For CentraSite these
typically would be:

■ Software AG CentraSite Registry Repository
OnWindows, the CentraSite Registry Repository runs as a Windows service. You can use the
Windows Services application that is provided with the operating system to start and stop the
service.

For other operating systems, and as an alternative method onWindows, you can start and stop
the CentraSite Registry Repository from the command line:

To start the CentraSite Registry Repository from the command line

■ Enter the following command on the command line:

inoadmin start CentraSite

To stop the CentraSite Registry Repository from the command line

■ Use one of the following commands to stop the CentraSite Registry Repository:
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DescriptionCommand

This option terminates the CentraSite Registry Repository session
normally andwaits for currently active processing to finish. Thewaiting
time in seconds can be set with the server property Maximum
Transaction Duration (see Repository Configuration Parameters).

inoadmin shutdown
CentraSite

This option terminates theCentraSite Registry Repository immediately.
User transactions that have not finished processing are rolled back.

inoadmin cancel
CentraSite

This option causes an emergency shutdown of the CentraSite Registry
Repository. All processing is stopped immediately. Crash dump files

inoadmin abort
CentraSite

will be written. This method will cause an automatic repair
("autorepair") the next time the CentraSite Registry Repository is
started, and should only be used as a last resort.

You can also use Command Central to start and stop the CentraSite Registry Repository. The
CentraSite Registry Repository is listed as a process in the instances list of your chosenCommand
Central environment, and you can use standard operations in the Command Central interface
to start and stop the process. Refer to the Command Central Help guide for details.

■ Software AG Runtime
OnWindows the Software AG Runtime runs as a service and can be started and stopped using
the Windows Administrative Tools.

On UNIX the Software AG Runtime can be stopped and started using the following scripts.

<SuiteInstallDir>/profiles/CTP/bin/sagctp<nn>.sh stop
<SuiteInstallDir>/profiles/CTP/bin/sagctp<nn>.sh start

where <nn> represents a product version number.

In case you need to install other products from Software AG you might be required to stop all
running components. Check with the specific product's instructions.

UNIX Installation Without Using sudo

On UNIX platforms, if you did not use sudo to install CentraSite, you must register daemons and
set file permissions by running the script <SuiteInstallDir>/bin/afterInstallAsRoot.sh as the root user.
This step will provide for the necessary startup procedures to be installed.

OnUNIX platforms, if you did not use sudo to install CentraSite, the rc scripts, which are typically
located under the /etc directory, are not available. The services and components can be started as
described above.
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3 After You Uninstall CentraSite

You can find generic instructions for uninstalling CentraSite in thewebMethods InstallationGuide,
which you can find at http://documentation.softwareag.com/. Basically, this entails invoking the
webMethods Uninstaller.

However, you should be aware that uninstalling CentraSite does not delete the CentraSite database
(Registry/Repository). There are many circumstances in which you should retain the database
after uninstalling CentraSite; for example, if the database contains information that is important
for your enterprise.

If you do wish to delete the CentraSite database, we strongly recommend making a backup copy
of its contents before you proceed. Then delete the directory <CentraSiteInstallDir>\data.
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